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THE NATIONAL ANTHEM

Jana-gana-mana adhinayaka jaya he
Bharatha-bhagya-vidhata,

Punjab-Sindh-Gujarat-Maratha
Dravida-Utkala-Banga

Vindhya-Himachala-Yamuna-Ganga
Uchchala-Jaladhi-taranga

Tava subha name jage,
Tava subha asisa mage,
Gahe tava jaya gatha.

Jana-gana-mangala-dayaka jaya he
Bharatha-bhagya-vidhata,

Jaya he, jaya he, jaya he,
Jaya jaya jaya jaya he!

PLEDGE

India is my country. All Indians are my
brothers and sisters.
I love my country, and I am proud of its rich
and varied heritage. I shall always strive to
be worthy of it.
I shall give my parents, teachers and all elders
respect, and treat everyone with courtesy.
To my country and my people, I pledge my
devotion. In their well-being and prosperity
alone lies my happiness.
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Dear Learners,

The Information and Communications Technology (ICT)
textbook for Standard IX is prepared and presented to you with
the firm conviction that the ICT textbook for Std VIII could
successfully guide you across the marvellous and ever
advancing world of information and communications
technology, providing you with various innovative learning
experiences.

You have already learnt the basic lessons of Graphic
Designing. This textbook has been prepared with the intention
of providing you with practice in using graphic software for
designing posters and pictures by yourself for curricular and
extracurricular activities, familiarizing you with the various
possibilities of word processor, equipping you to use software
like spreadsheet, presentation, etc. for doing various activities
including projects.

The activities included in this textbook are designed using
various interactive software like GeoGebra, RasMol, GPlates
and Stellarium. Which will help you to get a deeper
understanding of the various concepts. The textbook also
initiates you into the world of computer languages by providing
opportunities to prepare programs using Python. In addition
to familiarising the various services provided through Internet,
the textbook also offers practice in handling Wiki software.

This textbook that provides you with interesting and novel
learning experiences will prove to be a good companion to you
in the learning of other languages and subjects.

Dr. J. Prasad
Director

SCERT, Kerala

Preface



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901

CONSTITUTION OF INDIA
Part IV A

FUNDAMENTAL DUTIES OF CITIZENS

ARTICLE  51 A

Fundamental Duties- It shall be the duty of every citizen of India:

(a) to abide by the Constitution and respect its ideals and institutions,
the  National Flag and the National Anthem;

(b) to cherish and follow the noble ideals which inspired our national struggle
for freedom;

(c) to uphold and protect the sovereignty, unity and integrity of India;

(d) to defend the country and render  national service when called upon to do so;

(e) to promote harmony and the spirit of common brotherhood amongst all the
people of India transcending religious, linguistic and regional or sectional
diversities; to renounce practices derogatory to the dignity of women;

(f) to value and preserve the rich heritage of our composite  culture;

(g) to protect and improve the natural environment including forests, lakes, rivers,
wild life and to have compassion for living creatures;

(h) to develop the scientific temper, humanism and the spirit of inquiry and reform;

(i) to safeguard public property and to abjure violence;

(j) to strive towards excellence in all spheres of individual and collective activity
so that the nation constantly rises to higher levels of endeavour and
achievements;

(k) who is a parent or guardian to provide opportunities for education to his child or,
as the case may be, ward between age of six and fourteen years.
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for easy reference

For further reading
(Not to be evaluated)

Let’s evaluate

Extended activities
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These statements indicate the recent changes in
atmospheric temperature. You might have understood
how the change in atmospheric temperature influences
the climatic conditions.

In the lesson ‘Sun: The Ultimate Source’ in your Social
Science textbook, different types of analyses of
temperature in various parts of India are referred to. Anu
and Amina are getting ready to gather information on the
temperature in different parts of India as referred to in
the lesson and analyse them. Anu is of the opinion that
the activity is a bit difficult since a lot of data is to be
handled. It was their teacher who hinted that Spreadsheet
software could be used for analysing data and for arriving
at conclusions.

Chapter 6Chapter 6Chapter 6Chapter 6Chapter 6
Analysing Data in the Computer

Severe drought is in
store for us

Kerala sweats it 
out in

scorching heat
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With the help of LibreOffice Calc familiarised in
Standard 8, let’s help Anu and Amina to do this activity
as per the teacher’s instruction.

For this, they collected the data of the maximum and
minimum temperature at different parts of India from the
Internet. Then, it was tabulated in LibreOffice Calc as
shown in Fig.6.1. The table was saved with the name
‘Temperature’ in the prescribed folder in Home.

Fig. 6.1 Temperature at different areas

Weather information
on the Internet

Information regarding
the daily weather
conditions of all the
important cities in India
is available on the
Internet. We get daily
information from the
official website (imd.gov
.in) of the Indian
Meteorological Depart
ment under the Ministry
of Earth Sciences. The
department is entrusted
with the responsibility of
studying the climatic
changes and giving prior
warnings of natural
disasters.

How do we
do that?

The table of temperatures
is ready. Now, we have to

find out the daily mean
temperature at each place.
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Activity 6.1 - Let’s find the average temperature

Add the title Daily Mean Temperature to the first
cell of the column next to Minimum Temperature in the
table that you have saved. You know that you need to
divide the sum of maximum temperature and minimum
temperature by 2, to find the average temperature of any
town. You may remember from your previous classes the
way to find the sum. Here, you need to find the sum of
the cells from C2 to D2. Follow the process given below.

 Select the cell in which you intend to get the average
(E2).

 Type =SUM(C2:D2)/2 and press Enter key. (Fig. 6.2)

Now, save the file.

You can also find the
average, using the function
AVERAGE which is available
in LibreOffice Calc.

Moreover, you may use
the functions for making more
complex calculations and
analyses.

Daily Mean
Temperature

Daily Mean Temperature
is the average of the
maximum and the
minimum temperatures
in a locality.

Functions - A scaffolding

Don’t you remember the function SUM you have used to find the sum of numbers?
There are more than 350 functions in LibreOffice Calc to analyse and interpret data.
On the basis of their use they are classified into different categories as Mathematical,
Statistical, Logical, Financial etc.  We can open the Function Wizard using Function
Tool ( ) and also by selecting Function from Insert Menu. (Keyboard shortcut Ctrl
+ F2). You can select the necessary function from the window and give information
according to the instructions to get correct results.

AVERAGE, ROUND, IF, LOOKUP, COUNTIF etc. are some of the useful functions.

The user can construct his or her own functions in addition to the available ones.
You can learn more about this in your higher classes.

Fig. 6.2 To find the Average
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How will you find out the average temperature of
other cities? Do you have to repeat the activities  you have
done earlier? Is it possible to do this using Fill handle
that you have learnt earlier?

Select the cell E2 in which you have found the
average temperature and drag the Fill handle (the + sign
seen when the mouse pointer is brought to the right
bottom of a cell) downwards.

The required digits to be retained after decimal can
be determined using the ROUND Function available in
LibreOffice Calc.

Activity 6.2 - Let’s round off the decimal places

We can give the title Daily Mean Temperature
Rounded to the column (Column F) which is next to Daily
Mean Temperature Rounded. Try to do the activities by
selecting the cell (F2) where the result is to be obtained.

 Select the Function tool ( ) in the toolbar.

 From the window that opens, select ROUND from the
Function list and click Next.

 Click on the box Number and give the cell address
(here E2) in which the decimal place has to be rounded
(Fig.6.3).

 You have to give the number of digits that should be
there after the decimal point in the box called Count. As
we don’t need any number after the decimal point here,
we need not give anything (you can also type 0).

Now click on OK and drag the Fill handle in F2.

Do not forget to save the file.

What difference should be brought about in this
activity, if you want to show two digits after the decimal
point using the ROUND function?

Fig. 6.3  ROUND function
window

Calculations would
have been easier if
decimal places had

been avoided.



90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678

90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678

91

Analysing Data in the Computer

Information and Communications Technology - IX

Activity Function

Find the sum of cells from A1 to A6.

Find the average of the numbers in the
cells from A1 to A6

Round the number in A7 to two decimal
points

Find the average of numbers in the cells
from A1 to A6 as a whole number.

SUM = SUM (A1:A6)

ROUND &
AVERAGE

= ROUND(AVERAGE(A1:A6), 0)

Table 6.1 Functions and Instructions

What should be typed in the cell

Activity 6.3 - Let’s include the functions directly to the
cell

Complete the following table (Table 6.1) by finding
out how to include the necessary functions for the
activities given below.

Is it not possible to categorise the places in the table
as places with warm climate and those with cool climate
on the basis of a fixed norm? Calc has many functions for
categorising the data. Let’s see how the function IF is used
in this category.

When Fill handle is
double clicked

You know that to copy a
function or formula
easily to the next cell, it
is enough to drag the Fill
handle. Or, you may
double click on the Fill
handle and see what
happens. Does the
f o r m u l a / f u n c t i o n /
sequence get copied to
the downwards cells? It is
seen that in certain
situations this is not
possible. This can be
possible only if the data
are there in the columns
that precede or succeed
the column in which Fill
handle is used.

Now, we should
categorise the
places on the
basis of the

temperature.

Yes…places which
have a warm climate
and those with a cool

climate, right?
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Activity 6.4 - ‘IF’ to categorise data

There should be a criterion for categorising the data.
Imagine that you need to categorise places as those with
the average temperature below 250C as Cool Climate and
those above 250C as Warm Climate places. Add the title
Climate in the ‘G’ column which is next to Daily Mean
Temperature Rounded column in the table and try to do
the following activities.

 Click on Function tool, after selecting the cell where
you should get the result (G2).

 Select IF from the Function list in the Function Wizard
window that opens and click on Next.

 In the Test box, fix the average temperature as below
25°C, which is the criterion for categorisation. Using
the cell address you may add as F2 < 25 (Fig.6.4).

 In the Then value box, you should add what is to be
displayed if the norm is correct. (here “Cool Climate”).

 In the Otherwise value box, you should add what is
to be displayed if the norm is incorrect (here “Warm
Climate”).

 After that click OK and drag the Fill handle in G2.

You may save the file now.

Anu has a doubt at this point. If we want to compare
the climate of more than two categories, can we use IF in
such cases?

When you have to categorise the data into three or
more groups, LOOKUP function is more suitable than IF
function.

Activity 6.5 - LOOKUP for categorising data

Let’s fix the criteria for categorising the data just as
we used IF. For example, imagine that you are using the
following method:

Fig. 6.4  IF function window

Let’s include more
sheets

At the bottom left of the
Spreadsheet window, a
label Sheet 1 is indicated.
It means, the table that
includes temperatures is
the first sheet in this file.
You can include more
sheets according to your
need by a click on the +
sign that is seen here. The
Spreadsheet file that
includes more than one
sheet is also called a
Workbook.

In  Spreadsheet, facility to
give suitable names to
the sheets is also
available.



93

Analysing Data in the Computer

Information and Communications Technology - IX

Temperature below 20°C      - Cool Climate
Temperature between 20°C and 30°C - Moderate Climate
Temperature above 30°C       - Hot Climate

Save the table with the name ‘temperature_climate’
using Save As. Delete the data of the last column which
was categorised using IF and try to do the activities as
given below.

 Type the criteria either in the sheet of the table or in
any other sheet (Fig. 6.5). This is the LOOKUP chart.
Here LOOKUP chart is typed in Sheet2. (You should
remember that you can include any number of sheets.)

 Select the LOOKUP
chart wholly and click
on Define Range in the
Data menu.

 Give a name in the Name
box in the window that
opens and click OK.
(Here the name given is
Climate) (Fig. 6.6).

 Now, select the cell in which you want to get the result
in Sheet 1 and click on the function tool in the tool
bar.

 Select LOOKUP from the Function Wizard window
that opens and click Next.

 Give the cell address of the average temperature in
the Search criterion (here F2) box and the name of the
LOOKUP chart (climate) in the box named Search
vector (Fig. 6.7).

 Do not enter anything in the Result vector box.

 Now, click on OK and drag the Fill handle. Are they
categorised in the desired way? (Fig. 6.8).

There is a facility available in Calc to classify a
particular type of data and make a new table from the
table you have prepared. We use the facility named Auto
Filter for this purpose.

Fig. 6.6  Define Range window

Be careful while using
IF…!

While using IF, do not
forget to type in quotes
(“ “) when you enter the
sentences to be
displayed in the value
boxes. (“Cool Climate”,
“Warm Climate”, etc.)
But if the numbers have
to be entered instead of
sentences, it is not
mandatory. Don’t you
remember Strings and
Numbers that you have
studied in the previous
lessons?

Fig. 6.5  LOOKUP Chart
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Fig.6.8  Analyses of temperatures

Activity 6.6 - Let’s classify data

Suppose you want to find places that experience a
daily average temperature of 25°C. Let’s see how this
activity can be done using Auto Filter.

 Select any one of the cells from the title cells.

 Click Auto Filter tool in the Tool bar (Fig. 6.9) (Or,
select Auto Filter from the Data menu).

 From the buttons ( ) you see in the cells that have
the titles, click on the button which is close to the data
that have to be classified (here F1).

 Retain the tick marks of the necessary data in the
window that opens (here the
tick mark of 25 alone has to
be retained) (Fig. 6.10).

 When you click OK, you will
get the table of those cities
that have a daily average
temperature of 25°C.

 Include a new sheet in the
Spreadsheet window and
Copy Paste the table that
has been filtered. Then, save
the file.

You can filter the data by
selecting Standard Filter in
the Auto Filter window by fixing the criteria for filter.

Fig. 6.7 LOOKUP function
window

In this table, how can
I segregate only

those places which
have the same
temperature?

Fig. 6.9 Auto Filter tool
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Data can be filtered by setting criteria in the order More
Filters   Standard Filter from the Data Menu. Now,
filter the table and using this method, find out the
data in which the average temperature is below 20
°C.

You must also have faced such a problem while
copying the data prepared by a function or formula from
the Spreadsheet and pasting it in another cell/sheet.

We can solve this problem using the facility Paste
Special in LibreOffice Calc.

Activity 6.7 - Paste special

Add a new sheet to the Spreadsheet file. Copy the
names of places including title from the table and paste
them in the first column (Column A) in the new sheet.
Now, follow the process in the order it is given.

(1) Open the sheet that contains the table and copy the
column in which the climate is recorded along with
the title.

(2) Then, select the second column in the new sheet.
Select Paste Special from the Edit menu.

(3) Tick only Text and Numbers in the window that opens
and click OK (Fig. 6.11).

You may not be able to open the Spreadsheet file
that we saved in the computer that has a different

Fig.6.10 Auto Filter window

Fig. 6.11 Paste Special window

Oh, when I tried to
copy the names and

climate to a new sheet,
it didn’t work.

You’re right. Only
the names of

places are
correctly copied.
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operating system or office application, or on any other
device. This problem can be solved by converting this
file to pdf format.

Activity 6.8 - Let’s export as PDF

We have learnt in earlier units that files in pdf format
are supported by most of the operating systems. Now,
try to export the Spreadsheet file that you prepared to
pdf format.

Even if we save our Spreadsheet file, it is likely
that others may bring in changes to it. Such corrections
may create difficulty. Let’s see what facility is there in
Calc to solve this without hampering the freedom to open
and see the file.

Activity 6.9 - Let’s protect our file

You can protect your files from unnecessary editing
using the facility Protect Sheet. Follow the process given
below.

(1) Open the sheet that you want to protect.

(2) Open the Protect Sheet window from the Tools menu.

(3) Give a password in the box when it is demanded.
Type out the password again in the Confirm box and
then click OK.

(4) Save the file.

Now, try to edit the file. Does it work? What if you
need to edit the file again? Try to do it in the same way as
shown above.

Let’s interchange rows and columns

If you click Paste Special while you copy and paste the data in a row and tick on
Transpose under Options in the window (Fig. 6.11), then, the data will be arranged
in a column. If you copy more than one row using this facility, the rows will be
arranged in the same order as columns.

Online Spreadsheets

We have been discussing
the Spreadsheets that can
be worked by installing it
in the operating system.
But there are Spreadsheet
applications that can be
used online without
installing, in a computer
that has internet facility.
The major advantage of
online Spreadsheets is
that they support most of
the Spreadsheet formats.
But, online Spreadsheets
can be used only if you
agree to the conditions
specified by the
organisation that provide
them.
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LOOKUP chart

0 A

10

C
B

D

20

30

 A

 B

 C

 D

Let’s evaluate

1. Which of the following facilities is available for a table that you have included in a
sheet of LibreOffice Calc, if protected through Protect Sheet?

 The data in the sheet cannot be copied by anyone else.

 The data in the sheet cannot be edited by anyone else.

 The data in the sheet cannot be seen by anyone else.

 The data in the sheet cannot be printed by anyone else.

2. If you categorise the data using the following LOOKUP chart, in which category
will 41 appear?

3. As part of the activities of the School Health Club, find out the weight (in kg) and
height (in m) of all the children in your class. Calculate the BMI (Body Mass Index)
of each child by tabulating the data in LibreOffice Calc.

Hint : BMI = (weight in kg/height in m2)

4. Based on the table of BMI in the previous activity, use LOOKUP function and
categorise the health condition of the children as Under Weight, Normal Weight,
Over Weight and Obesity.

Hint : LOOKUP chart

BMI less than 20 - Under Weight

BMI between 20 and 25 - Normal Weight

BMI between 25 and 30 - Over Weight

BMI 30 and above - Obesity
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1. Tabulate the national income of the last three years of some countries using
LibreOffice Calc. Calculate the average national income of each country using
AVERAGE function.

2. Collect data on the population of all states in India and tabulate them in Calc. Using
the Filter facility, categorise only those states which have a population of more
than 8 crore. Add a new sheet and include this table in it. Give the name ‘Highly
Populated States’ to this sheet.

3. Collect data on the consumption of electricity for a period of ten days in the houses
of all your classmates and tabulate them in Calc. Calculate the daily average
consumption of electricity. Filter those houses where the average consumption is
more than 5 units and show them in a separate sheet. Visit these houses and create
awareness on the need to reduce the consumption of electricity.

4. Prepare a Spreadsheet table of School Kalolsavam which shows the grades
according to the given criteria, when the scores given by the judges for various
items are entered.

5. There are many Spreadsheet applications supported by different operating systems.
Collect information regarding them and list them in the following table.

Extended activities



Spreadsheet Application Developed by Operating systems that support
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All the pulsations of life on our Planet Earth are
controlled by the Sun. The very existence of the biosphere
depends on solar energy. You might have learnt about
the human deeds that cause changes in the atmospheric
temperature and also about the need for protecting the
Earth for the upcoming generation, in the lesson Sun:
The Ultimate Source in your Social Science textbook.

Varsha and Vipin are preparing a presentation in the
computer on the topic ‘Global Warming’, to be presented
at the seminar to be conducted in the school on the World
Environment Day. Can you help them? You are already
familiar with the presentations using LibreOffice in the
eighth standard. What are the prerequisites for this?

 Decide/finalize the content.

 Prepare the storyboard.

“IØp∂ kqcys‚ IÆpIfn¬ \n∂·n

h¿jn®p tcmjapWcp∂p

BSnapIn¬ame IpSn\ocp Xncbp∂p

BXncIƒ Ipfncp Xncbp∂p.”

-- Bhoomikkoru Charamageetham
(O N V Kurup)

Chapter 7Chapter 7Chapter 7Chapter 7Chapter 7
Making a Presentation Impressive

We can
prepare the
presentation

using Impress.
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
...........................................................................................................................


...........................................................................................................................

You know how to prepare a good storyboard, don’t
you? Now, you have to collect information, pictures and
videos required for the presentation. From where will you
get them?

You can gather information from various content
CDs, Internet and other digital collections. Then store it
in a separate folder.

You can start preparing slides, if you have completed
the ground work preparations. For this, open LibreOffice
Impress and type the contents needed for the slides. You
were taught in the previous class to give the appropriate
background colour to the slides. So you can give
background colour to the slides. What should be done to
give the same background colour to all the slides?

We have already been trained to give suitable
background colour from Properties in Slide menu. If we
click Masterview tab from Properties Window and Select
background colour, we can give the same background
colour to all the slides.

Slide Template

Slide templates are used
for getting uniformity on
the slides used for
preparing presentations.
Various built-in templates
are available in
LibreOffice Impress.
Downloadable free
templates are available
on the Internet too. If
needed, you can
download such templates
and include them in your
presentations. The slides
which are prepared using
a template will have the
following features:

 one design

 one background colour

 uniqueness in fontsI tried Slide 
Properties   

Background, but its
not working...

Then try using
Slide 

Duplicate Slide?

Using Master View
window

When the activities  in the
Master View window is
completed, we must close
the window by clicking
Close Master View button.
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Activity 7.1 - Select a template

Impress contains provisions for providing the same
background to all the slides. Let’s examine how the
templates can be included.

 Impress has provision to select templates as soon as
it is opened.  You can also select templates by clicking
on Master Slides tool from the Sidebar of the
Presentation Window (Fig. 7.1)

 The appropriate template can be selected from
‘Available for use’ bar in Master Slides Window.

You have already set the selected template as the
background of the slide. Now, insert a new slide. What
do you see? All the slides have the same background,
haven’t they? You may now save the prepared
presentation in the folder after giving it a file name.

Now, you may include information and pictures
needed for the presentation. You have practised how to
include pictures and information in a presentation in the
previous class, haven’t you?

Fig. 7.1 Impress window

Scrolling texts in
presentations

Scrolling texts can also be
made in presentations.
You have studied in
Standard VIII about
adding animations to
texts. We can create a
Scrolling text using the
following process :

 Type the required text
using the textbox.

 After Selecting Text,
go to Format menu
and click in the order
Object and Shape –
Text – Text Animation

 Click on Scroll
Through option seen
in the box below Effect
and select suitable
direction from
Direction and then
click OK.

What shall
we do to see

the words
again?

We included a
picture and the
words we typed

have disappeared!
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Activity 7.2 - Let’s include and arrange a picture

This happened because the picture came on top
of the text. If you can place the picture behind the text,
you can solve this problem. How can this be done?
Follow the instructions given below.

 Click on the picture and select it.

 Click on Arrange from the Format menu and select
Send to Back.
(You can also right click on the picture and perform
this process.)

Observe the changes that happen when you click
on the other options available on the Arrange menu.

You can also use the Arrange tool in the tool bar to
perform this process.

Activity 7.3 - Include a video

You have already included pictures and text. What
about including a video in our presentation? How can
this be made possible?

 Select the Slide to which the video is to be included.

 Click on Audio or Video in the Insert menu and
include the video you want to insert.

You can also click on Insert Audio or Video tool to
insert a video (Fig. 7.2).

Click and select the video that appears on the slide
and adjust the size of the video window, if necessary.
Now, view the presentation. Videos of all formats may
not play in the presentation if inserted like this. To play
such videos you can use the Interaction option.

Activity 7.4 - Provide interaction

While browsing/visiting websites, it is a common
practice to click on the links provided in them. Like
this, you can link from the presentation to the video
file using Interaction tool. (You can use this technique
to provide link to any files in any format).

 Select Object (text, picture, etc.) on the slide you
intend to include in the Interaction.

Fig.7.2  Window that includes
Audio or Video tool

Add audio files
You can insert audio files
in the same manner as you
inserted the video files.
Here, you have to select the
audio files and insert them
instead of the video files.

Into the slides...
You can link to a slide
using Interaction. Select Go
to page or Object  from
Action at Mouse Click.
Select Target (Slide No)
and click OK.
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 Select Interaction from Format menu. Alternately, the
window can be opened by clicking Interaction tool
(Fig. 7.3).

 When the Interaction window opens, select Go to
document from the box near the Action at mouse click
(Fig 7.4).

 Click on Browse and select video file and click OK
(Fig. 7.4).

What activities can be done this way using
Interaction? Find out other options and their uses in the

Action at mouse click box and
list them in the given table
(Table 7.1).

Think of including
additional information
related to the seminar. What
are the sources from which
you can collect the additional
information?

Is it practically possible
to include all the additional
information you have
collected in the presentation?

Fig.7.4  Interaction window

Fig.7.3  The window that
includes Interaction tool

Interactive buttons
The buttons needed for
giving Interaction can be
drawn using the tools in
the Drawing toolbar. After
selecting the button, click
on the Properties tool in
the Sidebar. What are the
changes that can be made
in the button?

Table 7.1 Action and their targets

Action Target

No action

Go to previous slide

Go to next slide

Go to first slide

Go to last slide

Go to page or object

Go to document

Exit presentation

to move back to the previous slide

to exit the presentation
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You can make use of the provision of hyperlink like
Interaction.

Activity 7.5 - Let’s hyperlink

You have seen a lot of information in the Internet
related to global warming. Now, think of how to link
Wikipedia to your presentation.

 Select the word in the slide which you intend to
hyperlink.

 You can enter the window by clicking on the
Hyperlink tool or selecting Hyperlink in the Insert
menu.

 Select Internet from the box on the left side of the
window (Fig. 7.5).

 Type the web page address (URL) to be linked in the
URL box (Fig. 7.5). The text you selected to give
hyperlink will appear in the Text box. This will be
the Mark-up Text. Click on Apply and then, OK.

Now, view the presentation. What changes occur
when the mouse pointer reaches the top of the mark-up
text? And what happens if you click on it? You reach the
web page which you hyperlinked earlier, don’t you?

Fig.7.5  Hyperlink window

Mark-up texts
You might have noticed
some underlined words
in blue colour while you
visit sites like Wikipedia.
You might have noticed
the changes when you
bring the mouse on the
top of it. These are called
Mark-up Texts. When
you click on it, you reach
the file to which the text
is linked. This process is
called Hyperlink.

While linking files
If you change the
position of the files you
included in a
presentation through
Interaction, Hyperlink,
etc., it may not work
properly in the
presentation. Therefore,
it is better to copy such
files to a folder in which
you intend to save the
presentation and then
link them to the
presentation.
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Activity 7.6 - Let’s insert a table

If you include the information you have gathered for
the seminar in the form of a table, the presentation would
become more effective. Consider the following steps to
include a table in the presentation.

 Select the slide in which you want to insert the table.
Then, click on Table in the Insert menu.

 In the box that opens, type the number of rows and
columns and then click OK. (You can also click on
the Table tool and select the number of rows and
columns required in the table.) Now, include the
information in the table.

 You can make the table attractive using the tools that
appear in the Properties window while selecting the
table.

You might have understood how to add rows and
columns in a table. Select the table and right click on it to
see the options available and their uses. If you insert a
chart in the slide with the details of the table, won’t you
be able to get the complete data at one go?

Activity 7.7 - Insert a chart

You have studied how to insert a chart in Spreadsheet
in Standard VIII. Now, let’s see how a chart can be inserted
in a presentation slide.

 Select the slide in which the chart is to be inserted.

 Click on Insert menu and then on Chart and the
window to insert the chart will open now. (This can
be done by clicking on the Chart tool also).

 Format the chart using the tools marked in the picture
(Fig. 7.6).

 After formatting, the chart can be inserted in the slide
by clicking outside the chart.

Include data in
charts

 To add data to the
chart, click on Data
Table and provide the
data in the window
that opens. You can
also add or delete
rows and columns in
the chart by giving
details here (Fig. 7.6).

 Click on Chart Area or
Chart Wall and
provide suitable
background colour to
the slide.

 Click on Title and give
names to the X and Y
axes of the chart.

How can I include
tables in a slide?
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Activity 7.8 - How to add presentation files

Will it be possible to add presentations prepared by
other groups on the seminar topic, to your presentation?
How is it done?

Let’s see what should be done to add a presentation
wholly or partly to another presentation  file?

 Select the slide which is at the point where you would
like to add the presentation file.

 Select the presentation file you intend to add by
clicking the Insert Slide from File from the Slide menu.
Select the file and click Open.

 Then, click OK in the Insert Slides/Objects that
appears.

Did you notice that all the presentation files that you
have selected have been included?

If you want to add only a part of the presentation or
only certain slides to the presentation file, select and copy
those slides and paste in the Slide Pane wherever it is to
be added (Fig 7.1).

Did you notice the change in the background colour
of the slides you have just added now? To solve this
problem, click on the Master page and select a suitable
template from it.

Fig.7.6  Window for inserting chart

Slide Pane...

What are the facilities
available in Slide Pane?

 See the Thumbnail
view of the slides.

 Select a slide easily.

 Copy - Paste a slide.

 Add new slides to
the presentation.

 Delete a particular
slide.

 Rename a slide.

 Arrange the slides.

 Hide a particular
slide.
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Now, let’s slide show the presentation.

After the slide show of the presentation, Vipin
noticed that certain text and pictures are repeated and
some are not in the expected position. The teacher told in
the class that it was due to some error in giving animation
to the presentation. If we animate an object more than
once, this problem may happen. How can we overcome
this problem?

Activity 7.9 - Slide sorting

You have seen how the arrangement of animation is
changed. How can you change the arrangement of slides?

 Click on Slide Sorter from View menu. The
presentation slide will appear together in a window.

 Drag the slide, the position of which you want to
change the position and drop it in the correct position.

 To go to previous window click Normal in View
menu.

Haven’t you saved the work that you have done till
now in a folder? Now, you may present the slides before
your friends.

 You can select Master Slide by clicking Master View from Properties window or
by clicking Master Slide from View menu.

 A window as shown in the picture appears. (Note that here you can see only the
master slide here).

 The colours, pictures, etc. you add as background will be seen in all the slides.

 Select whatever is needed from <date/time>,<footer>,<number>, etc. and then
add the data. Then the same will be included in all the slides. Unnecessary data
can be avoided.

Let’s make master slides

Did you notice the templates that you used while
selecting the slide design? You can make similar
templates of your own.

To arrange animation
 Select a slide.
 Click on the  Animation

tool from the Sidebar.
 Click on Up/Down

button after selecting
animation.

Facilities to make
changes in animation,
remove animation and
preview animation are
available in this
window. Find them.

Fig.7.7
Custom Animation window
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 When you thus prepare master
slides and then prepare the slides,
such designs cannot be edited in
Normal View Mode.

 Whatever change/editing done in
the master slide will be effected in
all the slides.

 To go back to the Normal View
Mode, click on Normal View in View
menu.

1. Which of the following tools from Arrange will you select to bring a typed text or
picture to the front of the slide?

a) Send to back b) Send Backward

c) Bring to Front d) Bring Forward

2. Which of the following from the Interaction window will you select to link the first
slide to the fifth slide in a presentation?

a) Go to document b) Go to page or object

c) Go to first slide d) Go to next slide

3. What will you do to remove a slide temporarily from a presentation?

a) delete the slide b) hide the slide

c) sort the slides using Slide Sorter d) click on the master page

4. Which of the following icons in the Hyperlink window will you select to link a
presentation in a previously prepared file through Hyperlink?

a) Internet b) Mail

c) Document d) New Document

5. What will you do to add only two slides from another presentation to the
presentation you have prepared?

Let’s evaluate
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 We have studied in the earlier classes how to convert a word processor file into
PDF. Convert the presentation file you have prepared into PDF format.

 Prepare a presentation as part of the IT Quiz competition in the School IT Fair by
setting a master page using Slide Master.

 Prepare a presentation on the topic ‘Ozone depletion and its Remedies’ based on
the lesson from your Chemistry Textbook.

 Prepare notes on the three important parts you see in the main Impress window
and their major features.

Extended activities



a) Insert slide b) Insert Duplicate slide

c) Insert media d) Insert file
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Anu and Amina are watching the programmes of
State School Kalolsavam at the Kalolsavam site. Apart
from the results of the competitions, all the stage
presentations are available as video in the Kalolsavam
site. “All the competitions staged in the Kalolsavam and
all the important events are shown in the social media”,
says Vipin.

Let’s prepare a page for the Kalolsavam

In the earlier classes, you have studied that a website
contains more than one web page. We can also construct
a website for including the details of the major events of
our school. We can add information about various
programmes organised at our school related to Sports,
Youth Festival, etc. and also programmes of excellence
in different pages of the school’s website.

Let’s see how the website with different pages can
be constructed. Shall we prepare a web page to show  the
programmes of this year’s School Kalolsavam?

What are the details and information to be included
in the web page that we intend to prepare?

Chapter 8Chapter 8Chapter 8Chapter 8Chapter 8
Designing a Web Page

How will you
make a

website?

Shall we make a
website to publish
the programmes of

our school?
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Activity 8.1 - Deciding the content

Open various websites from the Internet and analyse
their content and also how they are arranged.

Shouldn’t we make our webpages also attractive in
this manner?  Let’s list out the contents to be included in
the Kalolsavam page

 Heading

 Pictures


...........................................................................................................................


...........................................................................................................................

Now, let’s start preparing the web page. You know
that web pages are opened on web browsers. But web
browsers cannot prepare web pages. How the texts,
images, sounds, videos, etc. shall be displayed on the
web page are given as special instructions in the Text
editor. Accordingly, the browsers and visualise the
contents of these files language used for preparing such
web pages is called Hypertext Markup Language.

Activity 8.2 - Let’s create a web page

The set of instructions used to define the contents
and their arrangements in a web page are called HTML
tags. They are typed in angular (< >) brackets. The content
along with the HTML tags included in a webpage is called
HTML Element.

H T M L

Web pages are inter-
connected hypertext
documents. The markup
language used for
preparing these web
pages is called HTML.
In ancient days, symbols
were used to give
instructions to the
typesetter to set the type
for printing. The size of
letters, colours to be
used, slant of letters, etc.
for the text to be printed
were represented using
symbols or codes called
markups. Since HTML
language is marking up
the content, it is called
markup language. The
fifth authorised edition
of HTML is HTML 5.

HTML tags

When a web page is prepared, <html> (opening) tag is
given initially to denote the beginning and </html>
(closing) is used at the end, to denote the ending of the
page. The contents are given in between. The
instructions that contain an opening and a closing tag
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is called container tags. Those that do
not need a closing tag is called an
empty tag.

The common structure of HTML tags
in a web page is given in Fig. 8.1. The
main tags that come between the
<html> ... </html> opening and
closing tags are <head> tags and
<body> tags. The things related to a
web page which are not the contents
should be given under the <head> ...
</head> tag. Eg. <title>..</title>.
This is the instruction to show a text
on the title bar when a web page is
opened (Fig. 8.2). The content to be
shown in the web page should be
included in <body> ..... </body> tag.

Fig. 8.1 HTML page layout

Fig. 8.2 Title bar

 To prepare a Kalolsavam page of your school, open
a Text editor and type the instructions as given  in the
Picture (Fig. 8.3).

 Save this file in the sub folder Web page in your folder
with a name ‘kalolsavam.html’ and close it. (This text
file becomes a web page when you give the file
extension .html)

Fig. 8.3  Basic HTML tags
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Activity 8.3 - Adding a page heading

Include the name of your school as the main heading
and “Kalolsavam” as the sub heading in the web page
you created where ‘Content Area’ is typed (Fig.8.3).

To include this in the webpage, first open the file in
Text Editor. For this,

 Right click on this file.

 In the list that appears, click Open with Other
Application.

 Select the Text Editor from the list and click the Select
button at the right top.

 Open the file you have saved (Double click).

 Examine how the web browser displays the details
you have entered in the web page.

 Where is the text School Kalolsavam shown?

 What other contents can you see in the page?

Details in the webpage are to be included.  You might
have decided the content to be included in the webpage.
In that case, what should appear on the top of the page?

Look at the headings and subheadings in your text.
Likewise there are different tags to display headings and
subheadings in the webpage.  Using the model given
below you can give a suitable heading to your
Kalolsavam page.

<h1> FIRST HEADING </h1>

<h3> THIRD HEADING </h3>

Heading HTML Elements

FIRST HEADING

SECOND HEADING

THIRD HEADING

<h2> SECOND HEADING </h2>

Table 8.1  Headings

Oh! I am not able
to make changes
in the web pages
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Fig. 8.4  Instructions given to include a heading and the corresponding web page window display

Compare this instruction with the one you have
already prepared. Observe the changes happening to the
heading when you use h3, h4 tags instead of h1, h2 tags.
Find out the heading tags other than h1, h2, h3 and h4.

You might have heard the saying “A picture is worth
a thousand words”. You would have seen the images in
the websites you have visited? Don’t you think web page
becomes more attractive if suitable images are added?

Prepare a banner in Image editing software for your
Kalolsavam page. Let’s familiarise ourselves with
inserting the banner in the web page.

Activity 8.4 - Let’s include a banner

You know how to insert a picture in the word
processor, don’t you? In a web page, image file can be
inserted with the help of the HTML tag <img>. Along with
this instruction, the details of the kind of image to be
included, from where the image is to be included, the
size of the picture, etc. can be given using the attributes
src, height, width, etc.

For example: <img src=“images/banner1.jpg”  height=
“300" width=“1024">

Attributes

Attributes are instructions
given for additional
arrangements to be made
within a tag. Attributes
need be given in the
opening tags alone.

 If Text Editor is not there in the list, Click the View
All Applications button at the bottom.

See the html instructions given by Anu to include
heading and how the browser has displayed it (Fig.8.4).
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Fig. 8.5 Folder in which the web
page is saved

Fig. 8.6 Source of a web page in which an image is included

The background colour of a page is one of the major
factors that make a web page attractive. Background
colour should suit the content and to the images of the
web page.

Activity 8.5 - Change the background colour

With the help of the hints given below, give suitable
background colour to the web page you have prepared.
For this,

 Include background colour attribute along with the
<body> tag. Eg. <body bgcolor= “green”>.

 Instead of names of colours, you can also give
hexadecimal colour codes.

Eg. <body bgcolor = “#00ff00”>

As you have to give instruction for inserting a picture
and its position, the picture you intend to include can be
saved in the folder in which the web page is saved. The
pictures can be saved in a new folder (e.g. Images) inside
the folder ‘Webpage’ (Fig.8.5).

To insert this picture in the web page, open the web
page Kalolsavam.html in Text editor. Type the instruction
<img src=”images/banner1.jpg”> as shown in Fig.8.6. Don’t
give a closing tag for this instruction. Save this web page
and observe this page in the browser.

Relative path and
Absolute path

While creating a web
page, the position of an
image file is represented
in two ways. i.e.Relative
Path and Absolute Path.
Relative path is the way
in which the image has
been inserted here. But
the path to the image will
be clearly defined in the
Absolute path. The
absolute path of the
above image may be as
follows: /home/kite/
Desktop/Webpage/images/
banner1.jpg

It is appropriate to give
relative path to images
and files while creating
web pages. Only the web
page created with
relative path of the files,
will function properly
when copied to another
computer.
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Activity 8.6 - Adding a Text

Given below is the web page prepared by Anu in
which the Kalolsavam items are included (Fig. 8.7).
Compare it with the Kalolsavam page prepared by you.
What differences do you find?

Fig. 8.7 Web page that includes Kalolsavam items

 Anu has included the Kalolsavam items in it.

 The word ‘Items’ is given in bold letters.

 Words are given in colour.


...........................................................................................................................


...........................................................................................................................
You may also add the Kalolsavam items below the

picture in your web page as in the given model and make
changes in the page source.

Some HTML tags are given overleaf which will help
you to make the words attractive (Table 8.2). You may
try the tags and make the words attractive.

Insert paragraphs

When details are entered
in a web page, some times
you may have to include
more than one paragraph.
The text can be split into
paragraphs by giving the
tag <p> ... </p>. This is how
paragraphs are inserted in
a web page.

Line by line

Even though we type the
Kalolsavam items line by
line in the web page
source, they appear in the
browser as continuous
words depending on to the
availability of space. To
denote the end of a line,
the tag <br> can be given
and the words can be
arranged in different lines.

Hexadecimal colour code

You can mix the colours
like red, green, blue etc. in
various proportions to
form new colours. A
colour containing red,
green and blue beams with
the intensity from ‘0’ to ‘f’,
16 codes (hexadecimal)
can be represented using
6 digits. (e.g. :#5fd0ff)
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Table 8.2  Formatting tools

Objective Tags How to use

to make a text bold <b> <b> Kerala Nadanam </b>

to italicise a text

to ‘underline’

to give colour to the
text

to change the font

to increase the size
of the font

to change the colour
and size

to align at the centre

<i>

<u>

<font color=“red”>

<font face=“Verdana”>

<font size=5>

<i> Nadanpattu </i>

<font color=“red”
size=5>

<center></center>

<u> Ganamela </u>

<font color=“red”>Bandmelam
</font>

<font face=“Verdana”>Bandmelam
</font>

<font size=5>Kathaprasangam </font>

<font color=“red” size=5>
kathaprasangam</font>

Don’t you remember the table used in the presentation
software? Likewise, you can include a table in a web page
and display the contents in different columns and rows.

Look at the Kalolsavam items prepared in the web
page (Fig. 8.7). Now, discuss the advantages of arranging
these items in two columns as shown in Fig. 8.8.

Fig. 8.8 List of Kalolsavam items

<center>item</center>

Don’t forget to
use the closing

tag.
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Activity 8.7 - Let’s include a table

Given below (Fig. 8.9) are the instructions to include
the Kalolsavam items in a table of two columns. Like this,
prepare a table in your web page. Open the browser and
evaluate how it appears.

Fig. 8.9  Source of webpage in which table tag is included

You might have seen web pages with videos in it.
Now, let’s see how to insert a video in the web page.

Instructions Use

to include a table.

<tr>

to include rows and columns (cell) in each lines.

<table border=1> to thicken the lines of the table.

Table 8.3  Use of table tags

The instructions to include a table and its process
are given below. Supply the missing parts.
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Activity 8.8 - Let’s insert a video

Video files can be inserted in the same manner as
image files. The videos that are to be used in the web
page can be kept in a folder near the web page (e.g.
“video”). Use the instruction <video> </video> to insert the
video in the web page.

Insert a video of the programmes in your web page
with the help of the instructions given below and see how
it appears in the web page.

<video width=”400" height=”250" controls>

<source src=”video/oppana.mp4" type=”video/mp4">

</video>

In the <video> tag, out of the three attributes, width
and height are provided to adjust the size of the video as
it appears. To show the play and stop buttons of the video,
you have to include the ‘Controls’ attribute. Two attributes
‘src’ and ‘type’ are given in the source tag.  The attribute
‘src’ tells you which video is to be added, and the attribute
‘type’ indicates the type of video is used.

e.g. type=”video/mp4" or “video/ogg” or “video/webm”

Let’s design a table

Won’t it be better to add the video to the table?
Discuss with your friends and find out how you can do
this.

Fig. 8.10  Tables for page layout

Design the page using table

You can design a web page
according to your wish by
preparing table/tables and
include words, pictures,
videos etc. in it.
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You might have seen flash news in TV, haven’t you?
You can see words and pictures scrolling in various
websites. You can also scroll words in your web page.

Activity 8.9 - Scrolling texts

Scroll the text ‘Registration Started’ below the banner
of your web page.

You can scroll texts and pictures using the tag
<marquee> </marquee>. Usually words scroll from right
to left in a web page. But you can give special instructions
to the attributes to scroll the text rightwards, downwards
or upwards.

For example: <marquee direction=right> Registration Started</

marquee>

You might have noticed the change that happens to
the mouse pointer when it reaches the top of certain words
or pictures in websites. See what happens when you click
on it. Another page opens. These are hyperlinked texts
named Hypertext. You can give hyperlink from your web
page to other pages or to the school website or School
Wiki.

Activity 8.10 - Hyperlink to School Wiki

You have given the name of your school as the
heading of your web page. Now, hyperlink the school
name in such a way that when you click on it, School Wiki
will open.

Hyperlink

<a> - - - </a> is the tag which is used to give hyperlink
or to make a word in a hyper text. You have to indicate
the attribute “href” to denote the place to link the text.

For example, if you want to give hyperlink in the
name GGHSS Malappuram to the School Wiki, give the
instruction as: <a href=https://schoolwiki.in> GGHSS

Malappuram </a>.
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When you prepare your school website, the pages
in it can be linked to the main page by giving hyperlink
to the file name of the main page along with its path.

1. Which one of the following HTML tags can be used to give the heading of a page?

1. <title> 2. <br> 3. <p> 4. <h1>

2. Given below to the right are the HTML instructions prepared by Saleena to make a
web page. Prepare a web page using these instructions. Are these instructions
adequate to prepare this web page? Make changes wherever necessary.

Let’s evaluate

3. Match the list of items with the corresponding HTML instructions.

1 Image <body bgcolor>... </body>

2 Underline <a>.... </a>

3 Hyperlink <u>.... </u>

4 Background colour <p>...</p>

5 Paragraph <img src=...>
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 Prepare a web page which shows the sports activities in the school.

 Prepare web pages showing the excellence of your school. Connect them to one
another using hyperlink.

 Include a table of Kalolsavam winners in your web page. Give different colours to
the words and background of the table.

 Visit the page source of the website https://kite.kerala.gov.in. Evaluate the usage
of certain familiar instructions (Right click  View Page Source).

 Prepare a web page keeping in mind any of the web pages you have visited on the
Internet. (Design the layout of the web page using <table>)



Extended activities
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Vipin and Varsha are preparing a video documentary of Kalolsavam programmes to be included
in the Kalolsavam web page prepared by the Little KITEs Club. The details to be included in
the documentary were prepared by Saleena and based on that a visual presentation was also
prepared by Anu.

Which video documentary would you like to
prepare? Discuss with your friends and select a
programme conducted in your school for preparing a

Chapter 9Chapter 9Chapter 9Chapter 9Chapter 9

If you prepare video documentation of the important
programmes in your school, it will be an effective method
to evaluate and publish them. Which programmes can
be documented in this manner?

 School Pravesanolsavam

 Sports Meet

 Independence Day Celebrations

 Tour programme


...........................................................................................................................


...........................................................................................................................


...........................................................................................................................

Video Editing
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documentary.  Then, shoot the programme with details
that you intend to include in the documentary and save
it in your computer.

What should be done to the video clips that you have
saved in the computer, to combine them to make a video
documentary? List them out.

 Arrange the videos

 Remove the unwanted parts


........................................................................................…-

 ........................................................................................…

In your previous classes you have studied the
process of editing a text or image or sound in your
previous class. Recall the process of editing.

In a similar way, let’s see how you can prepare a
video documentary can be prepared using OpenShot
Video Editor which is included in the IT@School GNU/
Linux.

Activity 9.1 - Let’s familiarise openshot

Open OpenShot Video Editor in your computer and
examine the facilities provided in it. (Fig. 9.1)

Fig. 9.1 OpenShot Video Editor window

Video editing

Video Editing is the
process of arrangement
of videos in a suitable
manner and editing and
removing unnecessary
parts from a video. It also
includes the process of
adding dialogues,
background music,
special effects, title, etc. to
the video and organising
it for a presentation. In
earlier days, tape-to-tape
linear video editing
using video tapes were
common. Later, with the
introduction of
computers and video
editing software, non-
linear video editing
using digital facilities
became popular. Thus,
editing a part of the
video file with perfection
and speed was made
easier.

Now, there are various
software which help in
the process of video
editing. OpenShot Video
Editor, Kdenlive, Kino,
Pitivi Video Editor etc.
are some of the video
editing software
available in GNU/Linux.
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Activity 9.2 - Let’s start a video project

You are now familiar with OpenShot Video Editor,
aren’t you? Now, let’s start editing videos.

To edit the audio and video files stored in the folder,
the first step is to bring them to the OpenShot Project.

 For that import required video and audio files to the

project by using  button from the toolbar or

Import files from file.

 These can be seen in Video, Audio and Image tabs.
(Click Show All to view all files together).

 Video Transition, Video/Audio effects are arranged
in the Transitions, Effects tabs respectively.

It is better to save the Project file which you intend
to edit at the beginning itslef.

 Click Save Project in File Menu.

 Select your folder, give a name to the Project and then
click Save button.

Activity 9.3 - Files to Timeline

To edit the imported files, you have to move them
to the Timeline.

For this, drag them from the Project File to the
Timeline tracks below in the order in which they should
appear (Fig. 9.2).

OpenShot Video Editor

OpenShot Video Editor is
a simple video editing
software. The project was
started in 2008 by
Jonathan Thomas, an
American, with the aim of
producing a simple and
stable video editor for
GNU/Linux. Within two
years he produced a
stable version. The
OpenShot Video Editor
developed using Python
programming language
supports many other
video file formats.

While selecting a Project Profile
While selecting Video Profile, it is better to arrange Project profile in a suitable
manner before starting video editing.  New Video Profile can be chosen either by
clicking File  Choose Profile in OpenShot or by clicking the icon Choose Profile in
the main Toolbar.  It is desirable to choose the profile HDV 720 24p (1280x720) which
is set as default in the Openshot Video Editor.  The revised version of Openshot
supports the video formats such as HD and HDV.
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Fig. 9.2  When videos are included in the track

♦ You can run the clips or stop running them by pressing
the Space key in the keyboard or click on the Play/
Pause button in the Video Preview window.

You may include the parts of the video from the
Project Files to the Timeline track. You can add or cut
files in these tracks.

Activity 9.4 - Let’s compile video files

When the video clips that were to be edited had been
dragged and played, Vipin and Varsha had some doubts
regarding them.

Timeline

In the video editing software, film, picture, sound, title, etc. can be edited at the
timeline based on their timing.  In a timeline, normally there are video and audio
tracks. The process of editing is done by inserting the video files in the video track
and the audio files in the audio track. But in the existing version of OpenShot, there
is no separate track for sound clips. Instead, videos in video files or video tracks are
separated and then deleted to make audio files.
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How can you remove the unwanted parts from a
video?

 Identify the exact part to be removed by moving the
Playback head.

 Mark the part to be removed using Add Marker Tool
. (To remove the marking, right click on it and click

on Remove Marker.)

 You can cut the marked parts using the Razor Tool
 (Fig. 9.3).

 For deleting the unnecessary video from the track,
Right Click on the video and then click Remove Clip.
(For removing the selection of once selected tool, click
on the same tool again)

You have now removed the unnecessary parts from
the video clips. Now, include the existing video parts in
the track and edit them and arrange them (Fig. 9.4).Fig.9.3 using Razor tool

Playback head

The video clips in the
track appear in the video
preview according to its
position on the Playback
Head tool. When you
activate the Play button
on the timeline, the
Playback Head starts
moving through the clips
on the track. During its
movement, the Playback
Head displays/
produces sounds of all
the files on the track on
its path. While
displaying, the priority
will be given to the video
clips on the top of the
track. If there are no
videos on the top track,
the Playback Head
displays the video file
placed in the track just
below. But, for audio
clips this file is not
considered.

What if we
omited some

portion?

Do we have to
include the whole of
the video clip in the

documentary?

Fig. 9.4  When the edited video parts are arranged on the track
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Fig.  9.5  When transition is effected on videos

Slide Transition

You know how to prepare a slide presentation using
the presentation software. You have also studied how to
make the presentation attractive by giving slide transition
effect to the slides.

You usually use the technique of slide transition
when you have more than one slide to present. What are
the advantages of providing slide transition effect to
slides?

 Ideas in each slide will be specially noticed by the
audience.

 ...........................................................................................

Activity 9.5 - Let’s give transition

In films and telefilms, transition effects are provided
in between scenes to fully experience the change of the
scene. The video documentary that is prepared by you
can also be made attractive by providing transition effects.
For this, follow the process given below.

 Click on the Transitions tab.

 Include suitable transition effects in between the
video clips that are arranged in the track (Fig. 9.5).

Special Notice

Do not forget to save each
activity that you perform
while editing. Then only
it will be saved in the file.
So, click in the order File
 Save Project and save
the project intermittently.
The OpenShot project file
format is osp.
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Fig. 9.6  Adjusting the direction of transition

The timespan of transition can be adjusted between video files.  For this, place the
mouse pointer at the beginning or end of transition and drag as needed.

Activity 9.6 - Add effects

You might have understood how transition effect can
be added to the place where two video clips join together.
Apart from this, adding effects to all video clips is also
possible in OpenShot Video Editor. Follow the process
given below and add suitable video effects to the clips.

 Right click on the video clip which you have included
on the track.

 Provide effects like Fade, Animate, etc. one by one to
the video clips and play them through Video Preview
window and see how they work.

 Identify effects and include them in the video clips
suitably.

Including audio files

Don’t you have to include a background narration
along with the documentation? You would have already
kept ready the text to be included as description. This
narration can be included in the video file, only if it is
converted into a digital format.

While providing transition
To give transition between two videos in the OpenShot, it is better to arrange video
parts in the adjacent tracks above and below.  (Transition can also be given by
arranging video files in the same track.  But in this method, all effects need not work
effectively)  If necessary, we can adjust the direction of transition by using reverse
transition after right clicking Transition. (Fig. 9.6).
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Fig. 9.7  Sound file included in the track

Record the text for description using any Sound
recording software and convert it to an audio file format
(wav, mp3, ogg). Save it in your folder. You can use the
Audacity software which you have familiarised in the
previous classes or any other sound recording software.
If you intend to add music, collect such files in your folder
well in advance.

In the timeline of OpenShot Video Editor, there are
normally two tracks. If we include videos in the two tracks,
how can we include an audio file in it? We need a new
track for this purpose. See, how can a new track be added
and how can the sound file be inserted?

Activity 9.7 - Add sound files

 To add a new track, click on Add Track  icon or
right click on the existing track and then click on Add
Track above/Add Track below.

 Drag audio files in to the timeline in the same manner
as you included video files (Fig.9.7).

 In order to give the relevant background narration or
sound to a video, the sound file should be arranged
in the track just below the video track.

 In the video files, if the existing sound is not needed,
the same is to be removed before adding a new audio
file.  For this, right click on the video clip and select
single clip under Separate audio from the menu
(Fig.9.8). Only the audio file gets separated from video
file and it moves to the next track.  Select the file and
delete it to remove sound.  Likewise, if necessary, we
can retain the sound file and remove video.

If you need more tracks

Do you want to add more
tracks?  You can add more
tracks by clicking on Add
Track Above/Add Track
Below obtained by right
clicking on the current
track or by clicking on the
add track icon.
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Titles

While watching movies or documentaries you might
have seen at the beginning and the end the names of
persons who worked behind such films (titles).
In a similar way, you can also include titles/
acknowledgements in your documentary. Note down the
titles you intend to include in your documentary.

 School IT Club presents

 ............................................................................................

 ............................................................................................

 ............................................................................................

Now, do the following activities.

Activity 9.8 - Let’s include titles

 Open the project and choose appropriate template
by clicking on Title from Title Menu (Fig.9.9).

Fig.9.8  Split Sound file from the track

Fig. 9.9 Title Editor window
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 In the window the file name of the title slide and the
information to be displayed can be typed. The
required font colour and background colour are to
be selected.

 Click on the Save button.

 With this, the titles that are created appear under the
Images tab near the Project files.

 The Titles can be arranged in the appropriate places
in the same manner in which video files were added.

Activity 9.9 - Export the project

The video and audio files are now placed in different
tracks in OpenShot. If you want to make this file work as
a video, it has to be converted into a video file. Then, you
can play it using a media player. You can export your
project file to video format using the following process.

 Save the project.

 Open Export Video window
either by clicking on Export
Video  button or by
selecting Export Video from
the File menu.

 Give the file name and select
the folder to be saved,
profile and additional
options of the profile, etc.
(Fig.9.10)

 Then click on Export Video.
When the process is
completed, close the project
window.

Fig. 9.10 Export Video window

Video file formats

Digital videos are stored
in data computers in
various video file for-
mats. Some of the impor-
tant video file formats are
ogv, mpg, mp4, avi, flv, mov,
wmv, 3gp.
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Activity  9.10 - Let’s play the videos

Did you play the exported video files in the
computer? This can be done in two ways: Double click
on the video files or follow Right Click  Open with
and select a suitable media player and play the video
files. Are you able to open your video documentary in
all the media players in the computer? This video need
not necessary work in websites, tablets, etc.

In such cases, these video files can be converted to
other file formats with the help of software. WinFF,
HandBrake, etc. are the software packages that help in
converting these file formats in the GNU/Linux system.

Activity 9.11 - Changing the video format

Let’s convert the video documentary that we have
prepared, using WinFF software. For this, follow the steps
mentioned below:

 Open WinFF from Sound & Video menu.

Convert image files to video files

You might have stored many photographs of festivals/programmes held in your
school. Don’t you like to make a video file compiling all the photographs you have
stored? This facility is available in OpenShot Video Editor. Follow the process given
below.

 Open OpenShot software. Include all the image files together all the Project files
section of OpenShot.

 Select the images that are to be included in the video files (Ctrl+A).

 Right click on the selected pictures and click on Add to Time Line.

 From the window that opens, click on Transition, Transition time, etc. seen on
the Transition tab. Then, click on the Add button.

 It can be now seen that the image files have been given transition and are ar-
ranged on the track. (Here pictures are arranged in the same track).

 You may export this to a Project Video file.
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 From the columns seen below Output Details (Fig.
9.11) select the details of the format you to be
converted and the folder in which you have to save
the project.

Fig. 9.11  WinFF window

 Click on the Add  button to include the file for

which the format of which is to be changed, into the
software.

 Then, click on Convert  button.

Close WinFF window when the process is completed.
Now, check the output folder. You can see the file in it
with format change.

You may include this video documentary in the web
page that you have prepared earlier.

     Opportunities in Video Editing

Video editing provides numerous opportunities for those who have imagination and
interest.

Video editing plays a major role in improvising movies, documentaries and adver-
tisement.  Video editors work in various audiovisual fields including television and
cinema.  Many institutions are conducting various courses in this field. Sky is the
limit for those who have experience and expertise in the field of video editing.
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1. Which among the following is a video format?

(a)  mp3 (b)  wma (c)  wav (d)  avi

2. What is the need for exporting a Project file into a Video Editing software?

3. Prepare titles for the video documentary related to a tour programme of your school
in OpenShot Video Editor software.

Extended activities

Let’s evaluate



1. Prepare a video documentary on the life of the famous poet ONV Kurup, collecting
his poems, video clips and images from the Internet.

2. Prepare a documentary of the annual report to be presented on the School Annual
Day, using OpenShot Video Editor software.

3. Prepare a short film using OpenShot Video Editor software on the topic ‘Drug Abuse
among School Children’.

4. Convert a video file you have prepared to another video file format with the help of
WinFF software.
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Atul and Divya, who won prizes in IT Quiz
competition, came to school with two tiny boxes.
Everybody was astonished when Atul told that the
box contained a small computer named Raspberry
Pi. Kunjamina expressed her doubt whether a
computer could be made in such a small size. Jobin
at once cleared the doubt by saying that most of the
smart phones could perform all the tasks performed
by a computer.

Have you ever thought of how the computers
are varied in size, performance and facilities? You
know that equipment like smart phones and desktop
computers work with the help of a number of big and
small components.

Day by day changes occur in the size and shape
of computers and its allied instruments because of
the high leap in the field of electronics and information
communication technology. What other changes do
you observe?

 reduction of size

 increase in storage capacity increases

Chapter 10Chapter 10Chapter 10Chapter 10Chapter 10
Inside the Computer

Raspberry Pi

Raspberry Pi is a credit card
sized computer. The facilities
that are available in a normal
computer are also available in
it. But this consumes only very
low electricity. This computer
is designed mainly for
educational purposes. But
various computer programs
can be prepared with the help
of this computer. Using these
kinds of programs, this
computer has facilities to
control external equipment
also.
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 ...........................................................................................................................

 ...........................................................................................................................

Have you ever thought of what process goes on in a
computer when it works?

A computer stores the data that are received through
the input devices and gives them back whenever required
using the output equipment. In the previous classes we
have familiarised ourselves with some of the input /
output devices we use. Try to remember those devices.

The picture of an old model of a major input device
is given in Picture 10.1. Can you identify the device? This
is the old model of a significant input device called
mouse. Identify the differences between the old mouse
and the mouse we use today. Like this, drastic changes
are occurring in most of the equipment related to
computer.

In desktop computers, all components other than
input/output devices are kept inside a box called
cabinet. How are components like monitor, keyboard,
mouse, etc. connected to the cabinet? These are
connected to the ports seen in the cabinet of the
computer using different kinds of connectors. You have
identified the differences that have occurred in the
shape and function of a mouse over the years, haven’t
you? Likewise, the system of connecting the input/
output equipment to a computer also has changed
a lot.

Activity 10.1 - How to connect?

Interfaces of certain equipment and their names are
given in the table below. Examine the computers in your
school computer lab and write down in the table (Table
10.1) the names of equipment that can be connected to
each interface.

Examine how the keyboard and the mouse that you
use are connected to the computer. Instead of the various
types of ports of the earlier days, USB ports are used more

Fig. 10.1 Old model mouse

Are all the input /
output equipment
connected to the

computer in the same
manner?



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789

138

Inside the Computer

Information and Communications Technology - IX

Table 10.1 Various ports and connectors

Be Careful !

Carefully fix the connectors to the ports or else the pins in the connectors will get
broken or bent. This will lead to disruption of information transfer and the equipment
may get destroyed.

R J 45

Connectors Equipment Ports

Mouse

Keyboard

VGA (Video Graphics Array)

PS2

USB (Universal Serial Bus)

TRS (Tip-Ring-Sleeve)Connector

.............................................................

.....................................................

......................................................

......................................................

......................................................

......................................................

DVI (Digital Visual Interface)

HDMI (High Definition
Multimedia Interface)

.............................................................

.....................................................

.............................................................

.....................................................

.............................................................

.....................................................
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nowadays. What are the advantages of using USB
connectors? Modern computers need no ports or
connectors for different equipment. Moreover, the rate of
information transfer using USB technology is too high.

You have seen devices that can be connected using
USB.

Which output devices are used to present the visuals
from a computer?

 monitor

 projector

The output devices used to present the visuals from
a computer is the monitor (Fig.10.2). What kind of
monitors do you know? List them.

 CRT monitor

 LCD - TFT monitor

 ...........................................................................................

You have understood that monitors are attached to
computers through VGA (Video Graphics Array)
adapters. High-Definition Multimedia Interface (HDMI),
Digital Visual Interface (DVI) Display port, etc. are
modern interfaces that are used to transmit audiovisual
data.  You can gather more information using the Internet.

The data that we give as input in various methods
are later given as output through a complicated
processing. This is done with the help of microprocessors
in the Central Processing Unit (CPU) of the computer.
These highly important microprocessors are fixed inside
a computer.

Fig. 10.2 Monitor

 USB
(Universal Serial Bus)

USB is an advanced
technology that helps in
the speedy transfer of
information between
equipments. Apart from
ordinary USB connectors,
micro USB connectors to
be used in mobile phones
and cameras are also
available now. They are
used for supplying
electricity to those
instruments that require
a minimum electricity.
You might have seen
mobile phone chargers,
fans, lights, etc. working
using USB. The new
generation equipment
use the USB 3.0
technology which has
high speed data transfer.

Visual display unit

Monitors are commonly known as Visual display units. They use various kinds of
technology.
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Analyse the picture given (Illustration 10.1).
Microprocessors help to make basic mathematical
calculations and control the activities of input /output
equipment in the computer. The joint activities of the
software and other peripherals in the computer help in
getting the necessary information through output devices.

Cathode Ray Tube (CRT) monitors consume more electricity than other monitors.
But the Thin - Film - Transistor (TFT) and Liquid - Crystal - Display (LCD), monitors
that we use nowadays consume very little electric power and are more clear and
vibrant.

Light Emitting Diode (LED), Organic Light Emitting Diode (OLED) technologies are
also commonly used in display units. They provide clear and vibrant screen and
will also provide visual clarity.

Illustration 10.1  Working of CPU

Do you think that the microprocessors used in
different computers have the same speed and same
efficiency? How can you identify the features of the
processors used in your computer?

You can know the details of the computer and the
peripherals in it without even opening and examining
them. Many applications are available for this. Sysinfo is
such an application available in your computer.

Activity 10.2 - Types of Microprocessors

Open Sysinfo software in the computer (Fig.10.3).
Observe the features of the CPU in the systems used by
you and your friends. Who are the major manufacturers
of  microprocessors? Use the information given in Sysinfo
note, won’t you?

Examine what additional basic information you can
available about your computer in Sysinfo.

Those who leave the
stage

Who controls the
activities in
computers?

With the advancement of
modern technology, many
sources and components
have been replaced by new
technological devices. The
PS2 ports used for
connecting the mouse and
the keyboard, serial ports
used for connecting
printers and the parallel
ports are examples for
such replacements.
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In order to absorb the heat produced during the
working of various microelectronic components, a
heatsink and a small fan are attached with the
microprocessor.  A very important factor that influences
the working speed and efficiency of computers in the
microprocessor used in them. You’ve now understood
that there are different kinds of microprocessors. New
generation microprocessors have technology which

enables them to handle many instructions at the same
time. Frequency, cache memory, the speed of information
transfer to other components of the computer etc. are
features related to the efficiency of processors.

The information and instructions handled by the
microprocessors will be in the memory of the computer.
Where is the memory of the computer situated?

Fig. 10.3  Sysinfo window

Clock speed and cache memory

When a computer works, a lot of information is transferred to and from the CPU
many times within a second. The rate of information transfer in a microprocessor is
referred to as frequency or clock speed. If the clock speed of the microprocessor is
more, then the instructions it handles also increase. Clock speed is normally measured
in unit Hertz (Hz).

When the CPU works, it depends mainly on the primary memory of the computer.
Sometimes the CPU which works very fast may find it difficult to get the information
in time. Hence, facility is available in the microprocessor to retain the frequently
used information in the CPU itself. This is cache memory of the CPU. Processors
differ in their levels of cache memory.

• Computer 1

• Computer  2
• Computer  3
• Computer  4

System Model Frequency L2 Cash

•

•
•
•

•

•
•
•

•

•
•
•

Table 10.2  Features of the microprocessor
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Imagine that you are preparing an article in Word
Processor software. If the power supply stops, your file
will be lost. But if that file is saved we can retrieve it later.
The file would be in the temporary memory of the
computer before it was saved. But after the file is saved,
it is sent to the permanent memory.

Permanent memory and temporary memory

Computers store temporary information files in
RAM, a component which is made up of IC chips. When
the power supply stops, the data stored in the RAM get
lost. The hard disk in which the operating system and all
the other files are stored, is the permanent memory of the
computer.

If you increase the storage capacity of the RAM, the
processing speed of the computer will increases. Examine
the RAM available in your computer lab. You can see the
name of the manufacturer and the storage capacity of the
RAM. Examine and record these details.

Activity 10.3 - Know the storage capacity of RAM

You are now familiar with the Sysinfo application
which helps you to know the details of the components
within the computer. Now, find out the capacity of the
RAM in your computer and write it in the space below.

 .....................................................................................

How much percentage of the total capacity of RAM
is now being utilised by your computer for its working?

 ...........................................................................................

While performing some tasks like video editing, it
may require more memory than the existing capacity of
the RAM for its functioning. A part of the hard disk is
usually kept apart for these purposes. This is called Swap
Space.

Random Access
Memory (RAM)

Drastic changes are
taking place happen in
the structure and storage
capacity of RAM. We use
big size RAM in desktop
computers and small size
RAM in laptops. In
gadgets like smart
phones, tablets, etc., the
RAM is inbuilt in the
Motherboard. Nowadays
we use RAM which has
more storage capacity
than the RAM used
earlier.
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How much is the Swap available in your computer?

 ...........................................................................................

Hard disks

You have seen that the permanent memory of the
computer is the hard disk. Normally all files including
pictures, music, videos and the operating system of the
computer are stored in the hard disk. Hard disk drives of
various storage capacities are now available. Try to find
out the storage capacity (size) of the hard disk in your
computer. Is this facility available in Sysinfo? Examine.

Activity 10.4 - Let’s find the storage capacity
of the hard disk

Open Disks software in your computer.

Identify the storage capacity of the hard disk in your
computer and write it down.

....................................................................................................
Connect a USB flash drive to the USB port of the

computer. Examine the storage capacity of the USB drive.

Which are the data storage devices used nowadays?

 Hard Disk Drive (HDD)

 Solid - state Drive (SSD)

Becoming smaller

The vacuum tubes used
in the earlier computers
were very big in size.
After making transistors
using semiconductors,
the size of computers
became small. Later it
was due to the invention
of integrated chips which
contain millions of
transistors, that the size
of electronic equipment
has become smaller in
size and the efficiency has
gone up.

Units of data storage

The basic unit of the capacity of data storage devices is byte. A byte is eight bits. Bit
is a word formed from binary digit. A bit is a value of either a 1 or 0 (one, zero). You
have understood this in the lesson ‘Programming’. One kilobyte (KB) is made up of
1,000 bytes. Subsequently, higher units like Megabyte (MB), Gigabyte (GB) and
Terabyte (TB) are formed. In the place of Kilobyte and Megabyte, units like Kibibyte
(KiB) and Mebibyte (MiB) are also used. For further information visit the link https:/
/en.wikipedia.org/wiki/Kilobyte.
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 Secure Digital Cards (SD Cards)

 ...........................................................................................

 ...........................................................................................

You may collect more details regarding this with the
help of the Internet.

Motherboard

You are now familiar with the components of a
computer like CPU, RAM and hard disk drive, etc. When
the computer works, all these components and other parts
of the computer have to exchange the data. How is this
possible?

This happens through the motherboard or the main
board. Motherboard is a complicated circuit board which
contains a number of electronic chips and electric circuits.
All these components in the computer are connected to
the motherboard. The connectors of the input/output
equipment also reach the motherboard. Slots for
connecting the expansion cards can also be seen in the
motherboard. Now, you might have understood how the
motherboard got its name.

Switched Mode Power Supply (SMPS)

You have seen that many components are connected
to  motherboard. In order to transfer data, electricity is
inevitable. There are small and big components in the
computer. Do all these components need the same
quantity of electricity? Regular and accurate quantity of
power supply to components like motherboard,
processor, hard disk and DVD drive is carried out by the
equipment called Switched Mode Power Supply (SMPS)
(Fig. 10.4).

What process should start when you switch on the
computer? You know that the operating system is in the
hard disk. The instructions of the operating system in the
hard disk should reach the temporary memory RAM. All

Fig. 10.4  SMPS

Paths of information
transfer

The paths used to
transfer information
between computers or
between the components
in the computer are
called bus. Nowadays
Serial Advanced
Technology Attachment
(SATA) cables are used to
connect the DVD drive
and the hard disk drive
to the motherboard. This
helps in the speedy
transfer of information.
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the components including the CPU should become
functional. Where will these components get the
instructions from?

Examine Illustration 10.2. All these components
function from the instructions they get from the chip called
Basic Input/Output System (BIOS)  which is fixed in the
motherboard.

When you switch the power on, the first process that
takes place inside the system unit is known as  Power-
On Self-Test (POST). This is a test to examine whether
the components in the computer are functioning properly.

What happens after the ‘Power-On Self-Test’?

Booting is a process by which the operating system
in the hard disk starts functioning.

If the computer is not used for many days, do the
system time and date show errors? When there is no
power supply, the CMOS battery that lies near the BIOS
chip gives power to it. That is why there is no error in the
system time and date even when there is no power.

Activity 10.5 - Identify the major components in the
Motherboard

The motherboard of a desktop computer is given in
Fig. 10.5. Observe a motherboard available in your school
computer lab. Compare the motherboard with the model
(Fig. 10.5) and identify the parts. Complete the table given
(Table 10.3).

What will happen next?

Innovative development in the field of science and
technology has brought about drastic changes in the
shape and working of computers. The uses and services
of computers have encompassed almost all sectors. This
has moved beyond the mobile phones and computers to
the concept of ubiquitous computing. The facilities of the
computer and its services in the future can only be
visualised.

Illustration 10.2

System on Chip (SoC)

These are
Chips in
which the
control of
all the components of the
computer are included in
one integrated circuit.
Microprocessor, RAM,
storage components and
input/output controls
are  included in one
single chip. In this
System on Chip of smart
phones and tablets, the
controls of sound,
images, videos and
wireless communication
are also included along
with the microprocessor.
High speed and low
energy consumption are
their main features.

The activities while the
computer is turned on
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Fig. 10.5   Model of Motherboard

Green computing

Green computing is the environment friendly way of designing, manufacturing and
using electronic devices. It also includes the disposition of defunct materials and
waste in an effective manner.

Useless parts of computers, electronic devices such as phones have become a big
cause of pollution. These, Known as Electronic Wastes (E-wastes), they affect living
beings and affect the environment badly.

Using high durable and low power consuming equipment is a part of Green
computing.  What can we do to promote green computing?

 Shut down the computer and other electronic devices after use.

 Print on paper only when it is very essential.

 ....................................................................................................................................

 ....................................................................................................................................

No. in
the

picture

Name of the component
in the Motherboard

1

2

3

4

5

• Processor socket

• ....................................

• ......................................

• BIOS chip

• .......................................6

• .......................................

Table 10.3  Components in
Motherboard
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1. Find the odd man out and explain.

a) HDMI b) DVI c) Display port      d) Network cable

Computing in all fields

Ubiquitous computing is a situation in which the computer technology reaches you
wherever  you are in the world. This can be used in any instrument, in any place and
in any manner you like. Imagine a situation in which the Internet, mobile phones,
electronic chips, Global Positioning System (GPS), etc. come to  your help even if
you are on the road, or in a vehicle or in the kitchen.

For more details: https://en.wikipedia.org/wiki/Ubiquitous_computing

2. Where does the computer get the first instruction to load the operating system
when you switch on the computer?

a) Hard disk b) SMPS

c) DVD drive d) BIOS chip

3. On which one of the following does the speed of the computer depend?

a) Frequency of the microprocessor

b) Storage capacity of the RAM

c) Cache memory of the microprocessor

d) All of these

Employment opportunities in Computer field

Nowadays there are different job opportunities in the computer hardware field. You
can do repairs related to the hardware of the computer and activate (make them
work) them after undergoing some training related to this.  There are a lot of
opportunities in areas such as Green Computing, System on Chip, Robotics, e-waste
management, hardware designing etc.

Let’s evaluate
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 Conduct a hardware exhibition in your school collecting the unused or damaged
parts of the computer as part of the school IT corner activities. Exhibit the computer
parts with their details in writing.

 Compare the features like storage capacity, microprocessor, RAM, etc. of various
smartphones from the details you can collect from newspaper advertisements.

 Conduct a seminar in your class on the changes that had occurred to the following
components. You may collect details from the Internet. You may divide the class
into groups and assign each component to each group. You can present it including
pictures with the help of the presentation software.

a. mouse b. keyboard c. microprocessor d. monitor

 List down the E-waste materials in your school and house. Suggest ways to dispose
them off safely and publish the details in the school notice board.



Extended activities
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Let's know about cyber safety

There is absolutely no need to mention the advantages of Internet and Social
Networking sites. We have embraced their potential for communication,
entertainment and information seeking.
But over the period, it is seen that a lot of teenagers are being harassed and fall
prey  to the abuse of Social Media. You can easily prevent yourself from being
a victim, if you take a few precautionary measures while being online.

How Social Networking sites can be dangerous

• Sharing and posting too much of personal information such as phone
number, address, location, photos, etc., can be misused.

• Trusting  strangers believing their profile to be true can be  dangerous,  as  they
may not be the same as  stated.

• Snapshots of chats, photos, videos, etc., are saved and will be used for
blackmailing and threatening.

• Being cyber bullied by posting negative, derogatory comments, posts, photos,
etc. to tarnish one's image.

• Lots of predators and adult criminals are lurking online to trap children.

Tips for safe Social Networking

• Always keep your personal  information strictly personal.
• Customize your privacy settings so that others can see only the basic information.
• Just know about and manage your friends. Don’t trust all the online friends.
• Let your friends know that you are uncomfortable if they post something

inappropriate about you.
• Do not publish any information that reveals your identity.
• Always use strong passwords. Don’t share them with others.
• Never share your pictures, photographs, email accounts, etc., with anyone.
• Keep your personal messages strictly personal. Once posted they are published

for ever.
• If ever threatened or bullied seek the help of parents/teachers.

Crime Stopper: 1090
Cyber Cell (Tvm): 9497975998

Control Room: 100
Child Helpline: 1098 / 1517

Helpline Phone Numbers


	81-86
	87-98
	99-109
	110-122
	123-135
	136-152

